rekordbox Introduction

About this manual
Be sure to read this manual before using. This manual includes important
information that you must understand before using rekordbox.
• In this manual, name of buttons and menus displayed on rekordbox are indicated
with brackets. (e.g. [BPM], [Collection] window)
• Please note that depending on the operating system version, web browser
settings, etc., operation may differ from the procedures described in this manual.
• Please note that the language on the rekordbox screen described in this manual
may differ from the language on your screens.
• This manual describes functions and operations for rekordbox ver. 6.0 or later. If
you use an earlier rekordbox version than ver. 6.0, please download the suitable
manual from the FAQ on the rekordbox website.
• Please note that the specification, design, etc. of rekordbox may be modified
without notice and may differ from the descriptions in this manual.
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Introduction
rekordbox is composite software that manages music files and DJ performances.
With this music management software, you can manage music files in computers
and mobile devices (this includes analysis, changing settings, creating files, and
saving playback histories). It allows you to produce great DJ performances by
combining music files managed by rekordbox and DJ equipment produced by
Pioneer DJ.

About subscription plan
By signing up a subscription plan, you can enjoy DJ performances using more
functions.
For available functions on each subscription plan, refer to the rekordbox website.
rekordbox.com/en/plan/
Click [MY PAGE] in the upper-right of the screen to display the [MY PAGE] window,
and then click the [PLAN] tab to check or change your current subscription plan. For
details, see “Activating your computer with your subscription plan” (page 12).

Hint
• You can activate multiple computers and mobile devices with a single Pioneer DJ account. For
the number of computers and mobile devices that you can activate for each subscription plan,
refer to the rekordbox website.
• Even if you do not sign up a subscription plan, you can use more functions by connecting
supported DJ equipment. For details, see “About authentication by DJ equipment (Hardware
Unlock)” (page 11).
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Preparing rekordbox
Preparing rekordbox
Before using rekordbox, you need to install it and make settings.
Note
• For rekordbox ver. 6.0 or later, “rekordbox dj License Card” which is supplied with the Pionner
DJ equipment cannot be used.
(It can be used to activate rekordbox dj (PERFORMANCE mode) on rekordbox ver. 5 or earlier.)
Depending on the DJ equipment, when you connect it to your computer, you can use limited
functions of PERFORMANCE mode. For more details, see page 11.

Installing rekordbox
Before installing rekordbox, make sure to read “Software License Agreement”
(page 27).
If you are installing rekordbox, use the following procedures.
To install or uninstall rekordbox, you need to log on as the administrator of your
computer. Have the administrator name and password ready before starting.

1

Launch a web browser on your computer, access the rekordbox website
(rekordbox.com), and then open the rekordbox downloading page.
Information about how to install rekordbox and how to use rekordbox features
is displayed.

2

Click the button to download.

3

Read the terms of software license agreement carefully, and then click the
[Agree] checkbox to continue.

4

Click [Download].
Downloading rekordbox will start.

5

Double-click the downloaded file to unzip it.

6

Double-click the unzipped file to launch the installer.

7

Follow the instructions on the screen to install rekordbox.
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Launching rekordbox
Before starting rekordbox, log on as the computer’s administrator.
To use rekordbox for the first time, or if you have not already set up a Pioneer DJ
account for another version of rekordbox, the windows for setting up a Pioneer DJ
account will be displayed. Then with your computer connected to the internet,
launch rekordbox and follow the instructions on the screen to do the following.
If an earlier rekordbox version than ver. 6.0 has been installed, you must first convert
a previously used library to be used. For details, see “Converting the library of an
earlier rekordbox version than ver. 6.0” (page 9).
Hint
• With your computer connected to the internet, you can access the online manual and support
site from the [Help] menu on rekordbox.

For Mac
Select [Application] on the Finder, click the [rekordbox 6*] folder, and then doubleclick [rekordbox.app].
* This number stands for a version number.

For Windows
Double-click the [rekordbox] icon (shortcut) on the desktop.
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Setting up the Pioneer DJ account
1

Launch rekordbox.
The Pioneer DJ account setup window is displayed.

If you have already set up your Pioneer DJ account for an earlier rekordbox
version, this window is not displayed. You can use rekordbox without
procedures on this section.

2

Click [Create an account].
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3

Enter your name, email address, password, and country.
If you want to receive emails containing Pioneer DJ news, click the checkbox.

4

Read the terms of service and privacy policy, and then click the checkbox if you
agree with the terms.
If you disagree with terms, you cannot use rekordbox.

5

Click [Join Pioneer DJ].
An email with further account setup information will be sent to the email
address you entered.
If you do not receive the email, check the junk folder of your email software.

6

Complete the setup by following the information in the email.

7

Go back to rekordbox, enter the account name and password, and then click
[Setup].
rekordbox is available to be used by clicking [OK].

Entering administrator’s password (Mac) /
Allowing user account control (Windows)
If using a Mac computer, you will be asked to input a password. Enter the
administrator’s password of your Mac. If using a Windows computer, you will be
asked if you allow rbinit.exe to make changes on your computer. Confirm the
publisher, and then click [Yes].
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Converting the library of an earlier rekordbox
version than ver. 6.0
If you use the library of an earlier rekordbox version than ver. 6.0, you need to
convert it. (You can create an empty library without using the library of an earlier
rekordbox version.)
When you start rekordbox and answer the questions shown on the screen, the
following screen is displayed.

1

Click [NEXT].

2

Click [START].
The library conversion will start.
Click [NEXT] if you are not using the library of an earlier rekordbox version than
ver. 6.0.

Hint
• To cancel the library conversion, click [CANCEL]. You will need to convert the library again.
• Even if you cancel the library conversion or do not convert the library, you can convert it later.
Select [Import your library from ver. 5 (or earlier)] from [Library] in the [File] menu at the top of
the screen.
Note
• If there is not enough free space on the computer drive, an error screen appears. Check your
computer’s free space, and then click [Retry] to start the library conversion again.
• The library conversion may take time, and you cannot use rekordbox until the conversion is
complete.
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When the [Choose your plan] window is
displayed

Click [Choose your plan] to open the rekordbox website (rekordbox.com), and sign
up a subscription plan. For details on subscription plans, refer to “Compare plans”
on the rekordbox website.
rekordbox.com/en/plan/
Click [Click to proceed] if you have already signed up a subscription plan or do not
want to sign up one.
Note
• The information on the above window is just an example. For actual prices and applicable
services, refer to the rekordbox website.
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•
•
•
•
•

“About authentication by DJ equipment (Hardware Unlock)” (page 11)
“Activating your computer with your subscription plan” (page 12)
“Setting up KUVO” (page 13)
“Installing the audio driver” (page 14)
“Setting up the audio output” (page 14)

About authentication by DJ equipment
(Hardware Unlock)
Depending on the Pioneer DJ equipment, when you connect the DJ equipment to
your computer on which rekordbox is installed, you can use limited functions, such
as recording in the PERFORMANCE mode and the DVS function, without signing
up a subscription plan. For details on supported DJ equipment, refer to the
rekordbox website.
rekordbox.com/en/support/faq/v6/#faq-q1525
Refer to the Instruction Manual of the connected DJ equipment.
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Activating your computer with your
subscription plan
By signing up a subscription plan, you can use rekordbox on multiple computers by
logging in to them with the same Pioneer DJ account, and use limited functions.
Click [MY PAGE] in the upper-right of the screen to display the [MY PAGE] window,
click the [PLAN] tab, and then activate your computer.

4

1

5
6

2

3

1. Your current subscription plan
2. Next billing date for your current subscription plan
3. History for your subscription plan
4. Turn the activation on/off.
5. Expiration Date for your current subscription plan
6. Click here and select the following.
[Change/cancel your plan]: Change or cancel your subscription plan.
[Subscribe to a plan]: Sign up a subscription plan.
[Check for active devices]: Check the activation status on other computers and
mobile devices.
For details and notes on updating a subscription plan, check the FAQ provided
on the rekordbox website.
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Hint
• If you use the same Pioneer DJ account, you can activate multiple computers and mobile
devices with a single subscription plan. The number of computers and mobile devices that you
can activate is limited in accordance with your subscription plan. Therefore, if you purchase a
new computer and use it with rekordbox, deactivate an old one first.

Setting up KUVO
You can set your DJ performance information to be public or not. Click [MY PAGE]
in the upper-right of the screen to open the [MY PAGE] window. Click the [KUVO]
tab to set up KUVO.
For details on how to upload files to KUVO, refer to “rekordbox Instruction Manual”
on the rekordbox website.

2

1

3

1. User name of the KUVO profile (DJ name when publishing KUVO)
2. Open the KUVO website and change your user name.
3. Set the performance information for all tracks to public/private.

| To use KUVO
Refer to the configuration guide.
http://kuvo.com/kuvoweb/docs/configulation_guide/ConfigurationGuide.pdf
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Installing the audio driver
When connecting Pioneer DJ equipment to the computer, the driver installation
screen is displayed. Follow the instructions on the screen to install the driver. For
details, refer to the Instruction Manual of the Pioneer DJ equipment.

Setting up the audio output
Click
in the upper-right of the screen to open the [Preferences] window, and then
select the speaker on [Audio] of the [Audio] tab.
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About [MY PAGE]
Click [MY PAGE] in the upper-right of the screen to open the [MY PAGE] window.
The currently logged-in Pioneer DJ account is displayed in the upper-right of the
screen. You can switch the Pioneer DJ account.
1

2

3

4
5

6

1. Notifications from the rekordbox website (rekordbox.com) are displayed.
When you click the [Display at startup only when new information is available.]
checkbox at the bottom of the screen, you can set notifications to stop being
displayed when rekordbox starts if there are no new notifications.
2. Check or change your current subscription plan. (page 12)
3. Set the Cloud Library Sync function.
For details, refer to “Cloud Library Sync Operation Guide” on the rekordbox
website.
4. Set KUVO to be public or not. (page 13)
5. Pioneer DJ account is displayed.
When you click here and select [Switch Account], you can switch the Pioneer DJ
account.
When you click here and select [Change Profile], you can change the profile of
your Pioneer DJ account.
6. Close the [MY PAGE] window.
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EXPORT mode and PERFORMANCE mode
rekordbox provides two modes for your DJ set preparation and DJ performance.
Click [EXPORT] or [PERFORMANCE] in the upper-left of the screen to change the
mode.

About the EXPORT mode
When using the CDJ/XDJ series, rekordbox supports DJ performances which use
waveforms, cues, loops, beat sync, etc. by analyzing music files before starting.

You can enjoy various DJ performances using PRO DJ LINK by adding music files,
which are stored in your computer and USB storage device, to [Collection] of
rekordbox and managing them.
PRO DJ LINK has two export functions. Use USB EXPORT to export a managed
library of music files or playlists to a USB storage device or SD card. The USB
storage device or SD card is inserted into a DJ player. Use LINK EXPORT to
connect the computer to the DJ player. In both functions, you can share music files,
playlists, etc. with DJ equipment on the same network. For details of PRO DJ LINK,
refer to “Using with DJ equipment (PRO DJ LINK)” of “rekordbox Instruction Manual”
on the rekordbox website.
* LINK EXPORT is available only in the EXPORT mode.

You can enjoy simple DJ mix with the [2 PLAYER] mode.
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EXPORT mode and PERFORMANCE mode

About the PERFORMANCE mode
Use the PERFORMANCE mode for DJ mix performance on rekordbox. You can
enjoy professional DJ performances with up to 4 decks, 16 samplers, and various
features including the effect function.

Depending on your subscription plan, some functions may not be available.
For details on subscription plans, refer to “Compare plans” on the rekordbox
website.
rekordbox.com/en/plan/
Download and install the sample pack
You can download “sample pack” audio files which can be used for the rekordbox
sampler. Select [Sample Pack] > [Download Sample Pack] from the [File] menu at
the top of the screen. Downloading will start. After downloading, select [Import
Sample Pack], and then select the downloaded file. The downloaded file will be
imported to rekordbox. After the import, you can use the audio files for the sampler.
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System requirements
Before installing rekordbox, make sure to read “Software License Agreement”
(page 27).

| Supported OS
The latest information (supported OS, required operating environment, etc.) is
available on the rekordbox website.
rekordbox.com/en/download/#system

| Required system (minimum required operating environment)
Make sure that your computer meets the following system requirements before
installing rekordbox. For details on the latest information, refer to the rekordbox
website.
• CPU: 2.5 GHz dual-core Intel®processor Core™ i5
• Memory: 8 GB (or more) RAM
• Hard disk/SSD: 2 GB (or more) free space (excluding space necessary for storing
music files)
• Display resolution: 1 280 × 768 (or larger)
• Sound: Audio output to speakers, headphones, etc. (built-in or external audio
device)
• Internet connection: For the account registration or inquires, use a web browser
supporting 128-bit SSL (e.g. Safari 10 or later, Internet Explorer® 11 or later).
• USB port: A USB port is required to transfer music files to a USB storage device
(flash memory, hard disk, etc.) or to connect to a DJ controller.
• LAN port: An Ethernet LAN adapter (RJ45 port) is required for communication with
DJ equipment to transfer music files to a PRO DJ LINK compatible CDJ/XDJ
series, etc. For details, refer to the Instruction Manual of the Pioneer DJ product.
Note
• Full functionality is not guaranteed with all computers even when the above operating
environment conditions are fulfilled.
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• Even with the required memory capacity indicated for the operating environment above,
rekordbox may not provide full functionality and performance due to lack of memory in the cases
described below. Take the necessary measures to ensure sufficient free memory. Adding extra
memory, in order to achieve stable performance, is recommended.
– When there are many tracks being managed in the rekordbox library.
– When resident programs and services are running.
• Depending on your computer’s power saving settings, it may not be possible for your computer
to achieve its optimum CPU and/or hard-disk processing capacity. Especially with a laptop
computer, use an external AC power source to ensure best performance when using rekordbox.
• rekordbox may not operate properly if combined with other programs installed on your computer.
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Communications environment on the
computer
Depending on your computer’s security software and operating system settings,
communications with DJ equipment or mobile devices may be interrupted. If this
occurs, check your settings for the following 7 programs to ensure that they are not
blocked. The program extension depends on the OS of the computer; e.g. the
extension “.app” is for Mac and “.exe” for Windows:
rekordbox
PSvNFSd
PSvLinkSysMgr
edb_streamd
ls-unity-rekordbox-win
rbhttpserver
rbcloudagent.exe
When sharing of the computer’s internet connection is enabled, problems may arise
in communications with other computers or DJ units connected on the LAN. Disable
sharing before connecting the computer to the LAN.
• Mac: Open [System Preferences], and uncheck [Internet Sharing] under
[Sharing].
• Windows: Open [Local Area Connection Properties], and then at [Sharing],
uncheck [Allow other network users to connect through this computer’s Internet
connection] under [Internet Connection Sharing].
Communications with DJ equipment or mobile devices may also be interrupted if the
network (IP address, port number, etc.) is restricted by a router or another
communications device.
For details on the communications devices, security software, and the settings of
the operating system, contact the respective manufacturer or your sales agent.
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File formats that can be loaded and
played
Files that can be loaded and played on rekordbox are listed below.
• It may not be possible to read or play copyright-protected music files.
• For music files (file formats) that can be loaded and played on DJ equipment
produced by Pioneer DJ, refer to the Instruction Manual of the DJ equipment.

| Music files
Music
file

Compatible
formats

Encoding
method

Bit
depth

Bit rate

MP3

MPEG-1
AUDIO
LAYER-3

CBR
VBR

16 bit

32 kbps to 32 kHz
320 kbps 44.1 kHz
48 kHz

.mp3

MPEG-2
AUDIO
LAYER-3

CBR
VBR

16 bit

16 kbps to 16 kHz
160 kbps 22.05 kHz
24 kHz

.mp3

MPEG-4
AAC LC

CBR
VBR

16 bit

8 kbps to
320 kbps

16 kHz
22.05 kHz
24 kHz
32 kHz
44.1 kHz
48 kHz

.m4a
.mp4

WAVE

Uncompressed
PCM

16 bit
24 bit

—

44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.wav

AIFF

Uncompressed
PCM

16 bit
24 bit

—

44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.aif
.aiff

AAC
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Sampling
frequency

File
extension

Others
Music
file

Compatible
formats

Encoding
method

Bit
depth

Bit rate

Sampling
frequency

File
extension

Apple Lossless

Compressed
PCM

16 bit
24 bit

—

44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.m4a

FLAC

Compressed
PCM

16 bit
24 bit

—

44.1 kHz
48 kHz
88.2 kHz
96 kHz
192 kHz

.flac
.fla

| Video Files
• File extension: mpg, mp4, m4v, avi (Windows), qtz (Mac)
• Video format
– Codec: h.264, mpeg-4, mpeg-2
– Display resolution: up to 1 920 × 1 080
• Audio format: LPCM (aiff), aac, mp3

| Image files
• File extension: jpeg, png, gif (animated gif files are not supported)
* Depending on the OS or the operating environment of your computer, some files may not be
imported or played.
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Supported media (file system)
Note that rekordbox can only write to SD memory cards and USB storage devices
(flash memories or hard disks) which use a file system listed in the table below.
Recording
media

FAT16

FAT32

NTFS

HFS

HFS+

SD memory
cards





N/A

N/A

N/A

USB storage
devices





N/A

N/A



• To check the compatibility of SD memory cards and USB storage devices (flash
memories or hard disks) with your DJ equipment produced by Pioneer DJ, refer to
the Instruction Manual of the DJ equipment.
• HFS+ is available for Mac.
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Online support site
Before making inquiries on rekordbox operating procedures or technical issues,
read this manual and check the FAQ provided on the rekordbox website.
• AlphaTheta Corporation collects your personal information for the following
purposes:
1. To provide customer support for your purchased product
2. To inform you of product or event information via e-mail
3. To obtain feedback collected by survey for product planning purposes
– Your personal information is kept confidential corresponding to the privacy policy
set forth by our company.
– AlphaTheta Corporation's privacy policy can be viewed on the rekordbox online
support site.
• When making inquiries regarding rekordbox, please be sure to let us know your
computer type and specifications (CPU, installed memory and other connected
peripherals, etc.), the operating system and version used, as well as concrete
information regarding the issue at hand.
– To inquire about configuration of your computer with non-AlphaTheta
Corporation peripheral devices
and to obtain the corresponding technical support, contact the manufacturer or
retailer.
• Further version updates are anticipated for improved functionality and
performance of rekordbox. Update programs will be available for download on the
rekordbox online support site. We strongly recommend you check for the updates
to always use the latest version of rekordbox.
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Disclaimer
Please note that AlphaTheta Corporation cannot accept responsibility for the
legality, morality or reliability of operation with regard to the use of rekordbox by
customers. Problems in operation of rekordbox may arise due to the operating
environment of the customer’s computer and of rekordbox, or conflict with other
software.
Please note that AlphaTheta Corporation cannot accept responsibility for loss of
your registered information. Please make a separate note of information you have
registered and store it in a safe place.
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Copyright warning
The use of rekordbox is restricted with regard to the playing and copying of copyprotected music.
• The program may not operate properly if copy-protect encryption data is
embedded in recorded media.
• Playback, analysis, and other operations may stop if copy-protect encryption data
is detected as embedded in recorded media.
The material you record is for your own listening enjoyment, and cannot be used for
other purposes without permission from the copyright owner.
• Music recorded from CDs and other media may be protected by the copyright laws
of individual countries as well as by international convention. You are solely
responsible for the lawful use of the recordings you make.
• When handling music that has been downloaded over the internet, the person who
has downloaded the music is fully responsible for using the music in compliance
with his/her contract with the website from which the music was downloaded.
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Software License Agreement
This software license agreement (hereinafter referred to as the “Agreement”),
which applies between AlphaTheta Corporation (hereinafter referred to as the
“Company”) and the customer who wishes to use the Company’s software
(hereinafter referred to as the “Customer”), defines items related to the use of the
DJ equipment software (hereinafter referred to as the “Software”) and to the
documented materials supporting the use of the Software (hereinafter referred to as
the “Documents”).
Before installing or using the Software, please be sure to read the following
provisions carefully. When the Customer starts using the Software, that act of using
the Software is indicating the Customer’s agreement to the Agreement. If the
Customer does not agree to the Agreement, it must not install and use the Software.
(License)
Under the conditions of the Agreement, the Customer may install and use the
Software on a personal computer (hereinafter referred to as the “PC”) or mobile
device.
For paid-plan customers, there are the following restrictions on the number of
activatable devices:
Core plan: Two (2) devices
Creative plan: Four (4) devices
Professional plan: Eight (8) devices
(Software copyright, etc.)
The copyright and any other intellectual property rights of the Software and
Documentation are owned by the Company or its affiliates. The Software and
Documentation is protected by the provisions of the Copyright Act and international
treaties.
(Restricted rights)
The Company grants the Customer a non-transferable (including sub-licensing),
non-exclusive license to use the Documents, and use and copy the Software subject
to the conditions of the Agreement. The Customer may use the Documents to use
the Software and make a copy of the Software as a backup (only for the purpose of
restoration of the Software).
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(Restrictions)
It is prohibited to copy the Software or Documents unless the Agreement explicitly
allows this. However, the Customer may not sub-license, rent, lease, or lend the
Software. The Customer may not use the Software for the purpose of training third
parties or for commercial purposes. The Customer or any third party shall not
disassemble, modify, reverse engineer, reverse assemble, or reverse compile the
Software or create derivative works based on the whole or any part of the Software,
except to the extent allowed by applicable laws and regulations, nor attempt to do
any such things.
(About use of lyrics)
Usage of Lyrics is limited to your personal, noncommercial use in accordance with
the terms of this Agreement. You may not reproduce (other than as authorized for
your own personal usage), publish, transmit, distribute, publicly display, rent or lend,
modify, create derivative works from, sell or participate in the sale of or exploit in any
way, in whole or in part, directly or indirectly, any of the Lyrics so provided. You agree
that you are not granted any so-called "karaoke" or "sing-along" rights to Lyrics and
you shall not seek to or remove any vocal track from a sound recording that shall be
associated with a Lyric provided to you. You agree not to assign, transfer or transmit
any Lyrics to any third party. You agree that you shall not seek to or do anything that
will defeat, evade or circumvent any efforts that may be made to protect the Lyrics
from any unauthorized usage. You also agree that except as specifically authorized
herein, the foregoing restrictions apply to your use of Lyrics.
(About rekordbox Cloud Unlimited powered by Dropbox)
1. Start of use
To use rekordbox Cloud Unlimited powered by Dropbox (hereinafter referred to as
the "Cloud Service"), the Customer needs to follow the procedure described at
rekordbox.com/en/cloud-unlimited-setup-guide/.
2. Terms of use of Dropbox
To use the Cloud Service, the Customer shall comply with the terms and other
conditions shown at
www.dropbox.com/terms.
3. Restrictions
(1) The Cloud Service is a service that provides the Customer the Dropbox
storage that the Company is authorized to administer. It is prohibited to
engage in acts that disturb other customers, such as excessive use of the
storage capacity. Misuse of the Software or Cloud Service in a manner that
impairs network performance or causes excessive use of resources or costs,
including excessive consumption of cloud data servers, CPU time, memory,
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disk space, and session time, is prohibited. As the administrator, the Company
may use, save, or access the Customer's files to provide the service, or
exercise its rights or perform its obligations under the Agreement, and the
Customer grants the Company permission for these acts. The Company has
the right to investigate the Customer's activities and Customer content in order
to check compliance with the Agreement. The Company does not take any
responsibility for contents posted or shared by users of the Cloud Service.
(2) The purpose of the Cloud Service is to provide storage for materials required
for the Customer's own DJ activities. The Customer is prohibited from letting
any third party use their Cloud Service account (hereinafter referred to as a
"Cloud Service Account").
(3) If it is found that the Customer violates the Agreement (including, but not
limited to infringing third-party copyright), uses a Cloud Service Account
without permission, or violates any of the various Dropbox terms, use of the
Cloud Service may be declined, suspended or terminated.
4. Stopping use of the service
The Customer may stop using the Cloud Service at any time. The Company does
not take any responsibility for data uploaded by the Customer to Dropbox. The
Customer is asked to read and confirm the various Dropbox terms at
www.dropbox.com/terms and take necessary measures themselves.
5. Others
(1) The Cloud Service may be terminated without notice by Company at any time,
including without limitation due to the termination of the Company's contract
with Dropbox.
(2) The provision of the Cloud Service may be suspended due to a Dropbox
system reason.
(3) The support service contact for inquiries about the use of the Cloud Service is
as follows:
[Contact] Dropbox Business Customer Support (support@dropbox.com)
www.dropbox.com/support
(Third-party services)
The Customer is asked to understand that third-party services are not under the
Company's control. The Company does not take any responsibility for the use of
third-party services.
(Ownership)
All of the patents, copyrights, trademarks, trade secrets, and other intellectual
property rights, titles, and interests in the Software, Documents, and any derivatively
created product are owned by the Company or its licensors. The Customer will have
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no intellectual property rights in, or to, the Software or the Documentation, either
explicitly or implicitly, other than the right to use the Software and the Documentation
in accordance with the terms of the Agreement.
(Prohibition of violation of third-party copyright)
The Customer shall comply with the copyright law of each country and the
provisions of international treaties when using the Software. The Customer shall use
only legally obtained music data when using the Software. The Customer is
prohibited from conducting any act of eluding digital rights management (DRM),
even for legally obtained music data. The Customer shall not use the Software to
make a copy of music data beyond the scope of private use or transfer such a copy
to any third party. The Customer shall not share the recording media and cloud
storage where their music data is stored with third parties or use them for the
purpose of sharing with third parties. The Customer is prohibited from conducting
any act of saving any data in recording media and cloud storage available to third
parties or act of live streaming.
(Disclaimer of guarantee and technical support)
The Software, all the accompanying Documents, etc. are provided only "as is". The
Company neither guarantees the Customer and third parties the merchantability,
fitness for a particular purpose, non-infringement of others' rights, or any other
matters of the products above, nor does it guarantee to provide technical support or
the like for them. Mandatory provisions of some countries or regions may not allow
this disclaimer of guarantee. In that case, the disclaimer of guarantee may not be
applicable. The rights of the Customer may differ according to countries or regions.
(Compliance with export control laws and regulations)
The Customer may not use, export, or re-export the Software unless doing so is
allowed by the laws and regulations of the U.S. and those of the country where they
obtain the Software. The Customer may not export or re-export the Software to any
of the following parties:
(a) U.S embargo countries
(b) Anyone on the U.S. Department of the Treasury Specially Designated Nationals
List and anyone on the U.S. Department of Commerce Denied Person’s List or
Entity List
By means of using the Software, the Customer shall declare and guarantee that
they do not reside in a country falling under (a) above nor are they listed on the lists
in (b) above. The Customer shall be assumed to have agreed not to use the
Software for any purpose prohibited by U.S. laws and regulations (including, but not
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limited to, for the purpose of nuclear weapons, missiles, chemical weapons, or
bacteriological weapons).
(Remedy for violation and compensation for damage)
If the Customer violates any provision of the Agreement, they understand and agree
that the violation may cause the Company to incur unrecoverable damage greater
than pecuniary damages alone. Accordingly, without prejudice to any other rights
and remedies the Company may have the Customer agrees that damages alone
may not be an adequate remedy for violations of the Agreement and the Company
has the right to claim for suspension, and injunctive relief in addition to damages and
other available remedies, to prevent actual or threatened violations of the
Agreement.
(Termination)
If the Customer violates any provision of the Agreement, the Company may
terminate the Agreement, anytime whatever the reason may be. If the Company
terminates the Agreement with the Customer, all rights granted to the Customer
under the Agreement will be ceased, the Customer must stop using the Software,
delete copies of the Software and all the Documents from their PCs and mobile
devices where the Documents are located or where the Software is installed, and
notify the Company thereof via a written report. Even after the termination of the
Agreement, the restrictions, ownership, disclaimer of guarantee and technical
support, compliance with export control laws and regulations, prohibition of violation
of third-party copyright, remedy for violation and compensation for damage,
termination, limitation of liability, and effect of applicable laws shall remain effective.
Any suspected fraudulent, abusive or illegal activity is grounds for terminating this
Agreement and may be referred to appropriate law enforcement authorities.
(Limitation of liability)
With respect to any damage to the Customer resulting from the use or inability of
use of the Software and any accompanying material or service (including, but not
limited to, profit loss, business interruption, information loss and damage, and
damage due to compensation for damage based on a copyright violation or the like),
even when the Company (including its subsidiaries and affiliates to which this same
limitation of liability applies) is notified that such damage may occur, the maximum
amount of damages that the Company may incur shall be equivalent to the payment
made by the Customer for the license of the Software (or the annual fee paid by the
Customer for the subscription service covering the license of the Software if they
obtained the Software on a subscription service basis). Mandatory provisions of
some countries or regions may not allow this limitation of liability. In that case, the
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limitation of liability may not be applicable. The disclaimer of guarantee and
limitation of liability are essential elements of the arrangements between the
Customer and the Company.
(Applicable laws)
The Agreement shall comply with Japanese laws and regulations and be interpreted
based on them. The Agreement contains all the arrangements between the
Customer and the Company for the use of the Software and Documents and applies
in priority to any prior agreement on this matter (regardless of whether it is an oral
or written agreement). In case of dispute related to the Agreement, the Tokyo District
Court shall be the exclusive court of jurisdiction in the first instance.
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Trademarks and licenses
• rekordbox™ is a trademark or registered trademark of AlphaTheta Corporation.
• PRO DJ LINK™ is a trademark or registered trademark of AlphaTheta
Corporation.
• Windows® is a registered trademark of Microsoft Corporation in the U.S. and
other countries.
• Mac, and macOS are trademarks of Apple Inc., registered in the U.S. and other
countries.
• Intel® is a registered trademark of Intel Corporation in the U.S. and other
countries.
• Wi-Fi is a registered mark of the Wi-Fi Alliance.
• ASIO is a trademark and software of Steinberg Media Technologies GmbH.
• Other product, technology and company names, etc. mentioned herein are
trademarks or registered trademarks of their respective owners.
©2020 AlphaTheta Corporation.
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